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TEAMS Meeting Link      Meeting Call in Information
Meeting ID: 231 024 528 524                       +1 571-403-9146 
Passcode: SMZdLr                  Phone Conference ID: 989 870 18# 

https://teams.microsoft.com/l/meetup-join/19%3ameeting_YWRjYWYyN2EtNzgyMy00ZWE2LWE2YTMtZmYyOTkxNTA1YzU3%40thread.v2/0?context=%7b%22Tid%22%3a%221c21be44-2435-49bf-bc1f-cba317187058%22%2c%22Oid%22%3a%22ad5815de-5095-4600-8a86-0164be9d07a8%22%7d
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Housekeeping Items 
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Open Forum slides are sent in advance through 
1. CAS2Net Pay Pool Notices
2. CAS2Net What’s New
3. CAS2Net User Notifications

If you did not receive/see it,                                                                                               
enter your email address in                                                                                                  
the TEAMS chat.                                                                                        

Please remember to “Mute” your phone to prevent any background noise and 
additional feedback.
All Open Forum Sessions will be recorded.
Each recorded session will be posted to the AcqDemo website (including presentation 
slides) at https://acqdemo.hci.mil/training.html#cas2netOpenForums. 

https://acqdemo.hci.mil/training.html#cas2netOpenForums


http:/acqdemo.hci.mil

Weekly Open Forum 
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 12 September, 1pm – 2:30pm ET: Transfer, Archive and Post Cycle Activities
 19 September, 1pm-2:30pm ET: Changes in Sub-Panel Meeting and CMS 
 26 September, 1pm-2:30pm ET: Macro Free Sub Panel Spreadsheet and Macro 

Free CMS
o 03 October, 1pm-2:30pm ET: Discrepancy Reports
o 10 October, 1pm-2:30pm ET: Lock/Unlock Supervisor 1, Sub-Pay Pool and Pay Pool
o 17 October, 1pm-2:30pm ET: Pay Pool Analysis Tool (PAT)
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CAS2Net and CCAS 
Open Forum

Thursday
26 September 2024

1:00 PM Eastern Time

Topic: 
Macro Free Sub Panel Spreadsheet and Macro Free CMS

4
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Macro-Free SPS/CMS - Overview

• The Macro-Free Sub-Panel Meeting 
Spreadsheet (SPS) and Macro-Free 
Contribution Management Spreadsheet 
(CMS) are Microsoft Excel workbooks.

• The Macro-Free SPS and Macro-Free 
CMS workbooks must be downloaded 
from the Administrator section of 
CAS2Net located at 
https://cas2net.army.mil on and after 1 
October.

• For training purpose, Administrators 
may download/use the Macro-Free CMS 
from https://cas2net-training.army.mil. 
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https://cas2net.army.mil/
https://cas2net-training.army.mil/
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Excel Version Required
Excel for Microsoft 365, Excel for Microsoft 365 for 
Mac, Excel for the web, Excel 2021, Excel 2021 for 
Mac or newer

To find the version of Excel, you can follow these 
steps:
1. Click on “File”.

2. Navigate to Move, Help or Account.
3. Click on “Account” or “About Excel” or “About 

Microsoft Excel”.
4. A new window will open and show the version 

number … next slide.
5. In some cases, you will also find the full version, 

product ID, and a link to the copyright information 
… next slide.

1

2

3
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System Requirement
Excel for Microsoft 
365, Excel for 
Microsoft 365 for 
Mac, Excel for the 
web, Excel 
2021, Excel 2021 for 
Mac or newer

4. A new window will 
open and show the 
version number.
5. In some cases, you 
will also find the full 
version, product ID, 
and a link to the 
copyright 
information.
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CAS2Net > Macro-Free CMS/Subpanel Interface
To download/upload Macro-Free Sub-Panel Spreadsheet or Macro Free CMS
1. In CAS2Net, go to Administrator > Macro-Free CMS/SubPanel Interface
2. In Select Organization Download Type, select either Both or CMS or Sub-

Panel 
3. In Select Pay Pool, select your pay pool or sub-panel
4. Click Download or Upload 

Download Macro-Free CMS and upload

8

2
1

3
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Downloaded Macro-Free Sub-Panel Meeting Spreadsheet

Downloaded Macro-Free CMS
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS

Must Enable Content

Must close Check Performance                                            by clicking on 

What does the Check Performance do in Excel?
Microsoft released a Check Performance feature in the web version of Excel back in 2022. It 
searches for empty cells that still contain formatting data, such as custom text alignment or a fill 
color, and clears that data.

How do I turn off check performance in Excel?

It is currently not possible to disable this feature, but Microsoft is working on it. 
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CAS2Net > Macro-Free CMS/Subpanel Interface
Downloaded Macro-Free Sub-Panel Meeting Spreadsheet (SPS)

• Is populated 
• No need to 

download a file to 
import into the 
Macro-Free SPS

Downloaded Macro-Free CMS 

• Is populated 
• No need to 

download a file to 
import into the 
Macro-Free CMS

11
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
• The Macro-Free SPS and Macro-Free CMS 

– provide similar functionalities to the Macro-Enabled SPS and Macro-
Enabled CMS 

– some worksheets may lack specific features due to their operation 
without macros
• CMS - Printing the Part 1 must be from CAS2Net > Reports

– tested and verified macro-free data for the January pay transactions
• This Open Forum will be on the uniqueness in the Macro-Free SPS and 

Macro-Free CMS 

12
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Contents – Validation Status – Issues stopping a successful upload to CAS2Net
• Macro-Free SPS

• Macro-Free CMS

13
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
The Parameters worksheet is where the pay pool manager sets the 
parameters that define the pay adjustment scenario for the pay pool. The 
lines in white) are for information only and are not adjustable by the pay 
pool manager.
• Macro-Free SPS does not have a Parameters worksheet
• Macro-Free CMS
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
The Parameters worksheet is where the pay pool manager sets the 
parameters that define the pay adjustment scenario for the pay pool. 

– Check box if this is your 
organization first year in 
AcqDemo

– Check box if you want to add 
CRI remainder to CA

– Use Control Points
– Use Time Off Award

– CRI Funding %
– CRI Set-Aside
– Award Funding %
– Award Spent in CMS (<=90%)
– Non-CCAS Award for 

Remainder of FY
– Award Set-Aside
– Beta 1 (CRI)
– Beta 2 (CA) 

– Minimum CRI Dollar Amount
– Minimum CRI Carryover 

Amount
– Minimum Award Dollar 

Amount
– Award Proration Plan
– TOA Remainder
– Award Spending Summary

15
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Parameters – Alpha 1 for CRI and Alpha 2 for CA

16

Calculate Alpha 2
$119,676 / $ $492,666 =  0.2429

Alpha 2 * CA Pos DeltaY = Computed CA

Calculate Alpha 1
$130,779 / $125,799 = 1.0000
Alpha 1 is capped at 1.0000
Alpha 1 * CRI Pos DeltaY = (Default CRI) Alpha1DeltaY
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
• Parameters – impact of Beta 1 (CRI) Target Rail on Alpha 1

17

Change to

Change 

Change 
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
• Parameters – impact of Beta 2 (Award) Target Rail on Alpha 2

18

Change to

Change 

Change 
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Parameters
• Macro-Free CMS – CRI Set-Aside – Issue with switching from % to $
• Has % with 3.682% for Cash Amount of $5,000

• Decided to change to $ … error $4 … Cash Amount $4

• To correct, entered a dollar value, e.g., $5,000 

19



http:/acqdemo.hci.mil

Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Parameters
• Macro-Free CMS – CRI Set-Aside – Issue with switching from $ to %
• Entered as $ with $5,000 for Cash Amount of $5,000

• Decided to change to % … error ####%               … Cash Amount $6,788,950

• To correct, entered a % value, e.g., 4 … Cash Amount $5,431

20
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Parameters
• Macro-Free CMS – Award Set-Aside – Similar Issue with $ to % to $
• Entered as % of 10.000 for Cash Amount of $12,068

• Decided to change to $ … possible error $10 … Cash Amount $10

• To correct, entered a $ value, e.g., 12,000 … Cash Amount $12,000

21
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
The Macro-Free SPS Data worksheet is where the administrator can record, 
view, and edit the individual contribution factor scores.  The Macro-Free SPS 
Data worksheet has 58 columns, of which 10 are editable (highlighted in 
yellow of which 9 are for scores and one is for TOA) and 4 are wildcard 
columns.

The Macro-Free CMS Data worksheet is where the administrator can record, 
view, and edit the individual contribution factor scores and compensation 
adjustments, i.e., GPI, CRI, CA, TOA, CA proration, discretionary for GPI, CRI, 
and CA, CRI % split to salary, control points, supervisor and team leader cash 
differential, TOA. The Macro-Free CMS Data worksheet has 140 columns, of 
which 27 are editable (highlighted in yellow) and 8 are wildcard columns.
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – Tool Bar and Add-Ins

Macro-Enabled Sub-Panel Meeting Spreadsheet

Macro-Enabled CMS
 

23
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – Tool Bar and Add-Ins
• AutoFit Column Width and AutoFit Row Height
• Manually adjust the column width or row height or automatically resize 

columns and rows to fit the data. 
• Wrap text, so it appears on multiple lines in a cell. 
• Filter based on choices you make from a list, or search to find the data that 

you seek.  When you filter the data, the entire rows will be hidden if the 
values in one or more columns don't meet the filtering criteria. 

• Sort information to rearrange the data to find values quickly. You can sort a 
range or table of data on one or more columns of data. For example, you 
can sort employees —first by department, and then by last name.

• Hide or show rows or columns

• All the worksheets may be reformatted by reducing column widths, hiding 
columns, rows, etc.

24
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – Enable/Disable Table Highlight (Row/Column) 

• To enable highlight, click on Disable Highlight (Default View)

• To activate the drop-down icon  

• Select Enable Highlight

25
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – Enable/Disable Table Highlight (Row/Column) 
Select a cell, e.g., BAMA

Go to the Tool Bar                                >               > select highlight

Note the current version cannot highlight the editable/yellow cells 

26
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – Enable/Disable Table Highlight (Row/Column) 
Select the column data to highlight and select highlight

       

To highlight a row, select the row data and select the highlight 

27
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – Enable/Disable Table Highlight (Row/Column) 
To disable highlight, click on Enable Highlight  

to activate the drop-down icon  select Disable Highlight (Default View) …

all highlights are disabled                … If you enable highlights, the previously 
…………                                                     highlights will return 

28
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – Enable/Disable Table Highlight (Row/Column)

Caution

Best to highlight only the column cells or row cells

29

If you selected a column or 
selected a row like this to highlight

Upon disabling highlights, you will 
see … 
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – Find/Go to a Specific Column

To find and go to a specific column

30

Option 1 - click on the orange 
highlighted cell to activate the 
dropdown icon    
Click  to open/select from the 
picklist

Click                                      to go to 
the selected column  

Option 2 – type in the orange 
highlighted cell to filter by letters

Select Carryover Award

Click                                      to go to 
the selected column  
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – Wildcard and Formula … work in progress

31

Entered Formula Formula Applied 
to All

Saved and Uploaded Formula                                
Did Not Return
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
The OCS Charts worksheet is 
the scatterplots of 
the OCS vs. basic pay as of 30 
September  (SPS and CMS)
and 

the New Pay and 2025 SPL  
(CMS)

The OCS Charts worksheet 
shows the Upper, SPL, and 
Lower rails and each dot has 
the OCS and basic pay for the 
employee it represents.

32



http:/acqdemo.hci.mil

Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – OCS Charts
Tools

Since the Career Path, Broadband 
Level, and Name are not populated, 
you will need to activate the OCS 
Charts …

33
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – OCS Charts
Go to the Name box 
1. In the Name box – place cursor on the blue cell  changing the highlight to orange
2. In the Name box – click on orange cell to activate career path and broadband level
3. In the Career Path box – place cursor on a career path, e.g., NH
4. In the Career Path NH box – click … populate Name
5. Career Path – click on icon         to clear filter to populate all names in the sub-panel

34
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Data – OCS Charts
• Each dot has the OCS and 

basic pay for the employee it 
represents.  

• Future versions of the Macro-
Free SPS and Macro-Free 
CMS will display the actual 
names of the employees.

• Use the tools to filter by 
career path, broadband level, 
and/or name

35
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
The Rails and RoR 
worksheet provides a 
number of tables that 
provide counts and 
percentages of many of 
the key evaluation data. 

You may resize the Rails 
and RoR worksheet by 
adjusting the column 
width, row height, wrap 
text, hide rows, and 
hide columns. 

36
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Rails and RoR
The first table Rails Report shows rail position by career path based on the 
final (numerical) OCS by counts and percentages.

   
The word "Blank" might appear in your Rails Report, indicating employees 
with Presumptive Status 1, as seen in the blue highlighted cells. Although 
these employees are not eligible for an OCS and performance rating, they 
are accounted for in the Rails Report.

37
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Rails and RoR
The second table Performance Rating of Record shows by career path based 
on the rating of records by counts and percentages. 
  

Your Performance Rating of Record table might lack a description. The 
missing description, e.g., highlighted in blue, represents Presumptive Status 
1 employees. They aren't eligible for an OCS and performance rating, but 
they're accounted for in the table

38
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Rails and RoR
The third table Raw Average Rating of Record by Office Symbol provides the 
distribution of raw average PAQL by office symbol by counts and 
percentages.     

The missing description, e.g., blue highlighted cell, in the Raw Average Rating 
of Record by Office Symbol table below accounts for Presumptive Status 1 
employees.  Presumptive Status 1 employees are not eligible for an OCS and 
performance rating, but they are included in the table. 

39
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Rails and RoR
The plan for the fourth table is to provide the counts of the Delta OCS by 
Supervisor. Values of Delta OCS greater than 4 or less than -4 are grouped 
together since these values are relatively rare.  The current version of both 
the Macro-Free SPS and Macro-Free CMS did not provide that OCS 
distribution.      

The OCS distribution will be in a future update to the Macro-Free SPS and 
Macro-Free CMS

40
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
The Matrix worksheet is the rank order of employees by career paths, 
broadband levels, OCS, and individual factor scores. The Matrix worksheet 
has a tool bar with navigation buttons and a select career path picklist. The 
Matrix worksheet shows all the career paths and one or more career path 
panels,and broadband levels depending on the pay pool. The Matrix 
worksheet can be rank ordered by OCS and individual factor scores, either 
lowest to highest or highest to lowest, within each career path and 
broadband level.

41
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Matrix
You can reformat the Matrix worksheet by adjusting the column width and 
hide unneeded columns. 
Option to                       and filter and sort

42
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Matrix
Explanation for “blank” scores.  

The Matrix reflects the Presumptive Status and OCS from the Data worksheet

43
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
The Delta Stat worksheet is the summary statistics of Delta OCS scores by 
different groupings. The Delta Stat worksheet has navigation buttons, and a 
Column Filter to switch the groupings by selecting one of the options, such 
as Subpanel, Office Symbol, or 1st Level Supervisor. The Delta Stat worksheet 
shows the Summary Statistics of Delta OCS Score and the Delta Plot 
Grouping tables. The administrator can also hide or show the employees 
with only one employee in their group.
Delta OCS is the difference between an employee’s actual OCS and expected 
OCS, as computed from current salary and the formula for the SPL. 
Standard deviation is a statistical measure of the range, or dispersion of 
Delta OCS values.

44
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Delta Stat 
Column Filter to switch the groupings by selecting one of the options, such 
as Subpanel, Office Symbol, or 1st Level Supervisor. 

Click on                                  for the picklist 
                 Macro-Free SPS                                        Macro-Free CMS 

Future version will have filter by Wildcard.

45
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Delta Stat
The administrator can also hide or show the employees with only one 
employee in their group.
Show All or Hide Single Rated Employee Options

Click on                    for the picklist  
-  Show All
- Hide with only one Employee (If supervisors, sub-panel manager, or 

office symbol) have one employee, the manager may not want to 
display the results. These employees can be hidden by selecting the 
Hide with Only One Employee button. To display all results, select the 
Show All button.) 

- Filtered from Subpanel to Office Symbol and Hide with only one 
Employee 

46
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Delta Stat - Show All or Hide Single Rated Employee Options
Click on                    to

47
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Delta Stat 
Group by Career Path shows statistics by career path

48
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Delta Stat 
Group by Selected Filter
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Delta Stat 
Overall by Selected Filter
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
The Delta Plots worksheet is the graphical representation of the Delta Stat 
by different groupings. The Delta Plots worksheet has a tool bar with 
navigation buttons and a select career path picklist. The Delta Plots 
worksheet shows the standard, normal, bell-shaped curves reflecting the 
mean and standard deviation values of the Delta OCS scores for each group. 
The administrator can switch the career paths by selecting one of the 
options, such as NH, NJ, or NK. The administrator can also hover over a curve 
to see more information about the group it represents. 

51

Macro-Free SPS
Additional Work Required
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Delta Plot
For the Career Path picklist
In the Select Career Path                                      
click on             

to open the picklist 
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Delta Plot … For the Career Path picklist
In the Select Career Path                                     , click on             
to open the picklist                

then select NJ

53
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Delta Plot … For the Career Path picklist
Selected NJ

54

Compare NJ to 
All Career Paths
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
The Summary 
worksheet is a 
compilation of 
columns from the 
Macro-Free SPS 
Data worksheet or 
the Macro-Free 
CMS Data 
worksheet. 

55
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Summary
If there is no data

Go to the Tool Bar
1. Click Data
2. Click Refresh All
3. Click Refresh All

56
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS

The Summary worksheet initial view has these data columns. User can 
customize the Summary worksheet by adding to and/or deleting any of the 
default columns. 

57

Place mouse on a cell                    to activate pick list                                  scroll to pick data          data selected
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Summary

58

5 6
Added

Right mouse click on a cell          to open Refresh > click Refresh                                                         column added
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Macro-Free Sub-Panel Spreadsheet and Macro-Free CMS
Summary – to remove a column
Select a column label                     right mouse click               select Refresh

                                                                  Column removed

59
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PPA Advisory 2024-15 System Check for EOY CCAS 
Spreadsheets
Macro-Enabled Sub-Panel Meeting Spreadsheet, Macro-Enabled CMS, and 
Macro-Enabled Pay Pool Analysis Tool (PPAT)
• Digitally signed version 

– 2024 Sub-Panel Meeting Spreadsheet v1digitallysigned.xlsm
– 2024 CMS v1digitallysigned.xlsm
– 2024 Pay Pool Analysis Tool v1digitallysigned.xlsm

• Unsigned version  
– 2024 Sub-Panel Meeting Spreadsheet v1.xlsm
– 2024 CMS v1.xlsm
– 2024 Pay Pool Analysis Tool v1.xlsm

Excel > File > More > Options > Trust Center > Trust Center Setting > Macros Settings

Macro-Free Sub-Panel Meeting Spreadsheet and Macro-Free CMS
• Must have Excel for Microsoft 365, Excel for Microsoft 365 for Mac, Excel 

for the web, Excel 2021, Excel 2021 for Mac or newer
Excel > File > More > Account 
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CAS2Net and CCAS End of Cycle
• Tuesday 1 October 2024

o End of Cycle Modules
 Appraisal Status
 Offline Interface
 Previous Cycle Data
 Sub-Panel Meeting
 CMS Online
 Macro-Free CMS/Subpanel Interface

o Pay Pool Notices
 2024 Sub-Panel Meeting Spreadsheet v1.xlsm
 2024 CMS v1.xlsm
 2024 Pay Pool Analysis Tool v1.xlsm
 2024 Sub-Panel Meeting Spreadsheet v1digitallysigned.xlsm
 2024 CMS v1digitallysigned.xlsm
 2024 Pay Pool Analysis Tool v1digitallysigned.xlsm

o AcqDemo web site
 2024 Sub-Panel Spreadsheet User Guide
 2024 CMS User Guide
 2024 PAT User Guide

61
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CCAS Pay Pool Spreadsheets
For the 2024 CCAS pay pool upload 

 
Export file from the 2024 CMS v1.xlsm
or
Export file from the 2024 CMS v1digitallysigned.xlsm
or
2024 Macro-Free CMS

for the upload to CAS2Net
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End of Cycle Key Dates

63

DCMA  6 Dec 2024
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2024 Open Forum Schedule

64

 04 January, 1pm – 2:30pm ET: CCAS Pay Transactions for Regional Pay Offices
 01 February, 1pm – 2:30pm ET: CCAS Grievance and Archive/Transfer
 07 March, 1pm – 2:30pm ET: Assigning Mandatory Objectives, Mid-Point Review, Additional 

Feedback, and Closeout Assessment
 04 April, 1pm – 2:30pm ET: Communicating with AcqDemo Program Office on CAS2Net and 

CCAS Issues 
 02 May, 1pm – 2:30pm ET: Reports – FY-based Reports & Current Settings Reports 
 06 June, 1pm – 2:30pm ET: Macro Free Sub Panel Spreadsheet and Compensation 

Management Spreadsheet (CMS) Introduction
 11 July, 1pm – 2:30pm ET: Creating Sub-Organization Levels and Assigning Sub-Panel 

Managers, and User Role Assignments
 01 August, 1pm – 2:30pm ET: CCAS Spreadsheet Test Schedule (Offline Sub-Panel Meeting 

Spreadsheet, Offline CMS, Macro Free versions, and CAS2Net Online versions)
 05 September, 1pm – 2:30pm ET: Post Cycle Modules (Appraisal Status, Offline Interface, 

Previous Cycle Data, Sub-Panel Meeting and CMS Online)
 12 September, 1pm – 2:30pm ET: Transfer, Archive and Post Cycle Activities
 19 September, 1pm-2:30pm ET: Changes in Sub-Panel Meeting and CMS 
 26 September, 1pm-2:30pm ET: Macro Free Sub Panel Spreadsheet and Macro Free CMS
o 03 October, 1pm-2:30pm ET: Discrepancy Reports
o 10 October, 1pm-2:30pm ET: Lock/Unlock Supervisor 1, Sub-Pay Pool and Pay Pool
o 17 October, 1pm-2:30pm ET: Pay Pool Analysis Tool (PAT)
o 07 November, 1pm-2:30pm ET: Initial and Final Upload 
o 21 November, 1pm-2:30pm ET: Not Final Reports and Data Complete Reports
o 05 December, 1pm-2:30pm ET: Grievance/Grievance Window
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Open Forum
Questions?
AcqDemo.Contact@dau.edu  

Erin.Murray@dau.edu 
jerry.lee@dau.edu 

65
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